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KAPITEL 1

Neue Funktionen

1.1 Widget Presets

Dieses Feature vereinfacht die Verwaltung und das Speichern der GUI-Einstellungen (WidgetPresets). DieSchwerpunkte sind:
• Verwaltung der GUI-Einstellungen an einer Stelle im LoCo
• Speichern der Presets auf dem Server
• Disziplin- und projektabhängige Definitionen von Standard-Presets durch die KeyUsers

Hinweis: Dieses Feature befindet sich noch im Beta-Stadium. Es muss mit der Kommandozeilenoption
--enable-new-widget-presets aktiviert werden.
Die Auswahlliste der Disziplin wird nicht mehr im oberen Bereich neben der Projekt-Auswahlliste, son-dern in der unteren Menüleiste angezeigt.
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Daneben wird eine Liste der verfügbaren WidgetPreset angezeigt.
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Über View > Window > Administration > WidgetPresets kann der WidgetPresets-Editor geöffnet werden:
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Hier werden alle vorhandenen WidgetPresets gelistet. Es kann zwischen zwei WidgetPreset-Typen un-terschieden werden: Server und Local, die auf dem Server bzw. in der lokalen LoCo-Instanz gespeichertsind. Auf dem Server dürfen nur User mit der Rolle KeyUser WidgetPresets speichern und editieren. Alleanderen LoCo-Anwender können ein auf dem Server gespeichertes WidgetPreset verwenden oder eige-ne lokale Versionen davon ableiten. Der Anwender kann die GUI-Elemente (angezeigte Spalten, Filter, ...)nach seinen Anforderungen einstellen. Bei Änderungen und Auswahl des “Server”-WidgetPreset wird au-tomatisch ein neues lokales WidgetPreset erstellt, das den gleichen Namen wie das Server-Preset trägt,aber mit einem * vor dem Namen gekennzeichnet wird.
Wird ein WidgetPreset Yaris_dev CRASH vom Server geladen und eine Änderung an einem Filter vorge-nommen, erzeugt LoCo automatisch eine Version Yaris_dev CRASH.

Der Save-Button wird in diesem Fall aktiviert und bietet die Möglichkeit, das neu erzeugte Widget-Preset als Local, d.h. lokale Kopie zu speichern. Wenn ein lokales WidgetPreset gewählt ist und GUI-Einstellungen verändert wurden, wird automatisch das gewählte WidgetPreset überschrieben.
Darüber hinaus gibt es die Möglichkeit, ein WidgetPreset als eine .xml-Datei zu speichern und in eineandere LoCo-Instanz als WidgetPreset zu importieren.

Anwendern mehrerer LoCo-Instanzen, die keine Berechtigung zur Speicherung von WidgetPresets aufdem Server haben, ist es möglich, die WidgetPresets instanzübergreifend zu nutzen. Das in einer In-stanz generierte und auf Festplatte exportierte WidgetPreset, kann in einer anderen LoCo-Instanz überRechtsklick im WidgetPresets-Editor und Add auf einem früher erzeugten lokalen WidgetPreset impor-tiert werden.
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1.2 Prozess-Feedback

Mit dem neuen Prozess-Feedback-Feature wird der Fortschritt eines Jobs in der Jobs-View wesentlichdetaillierter angezeigt.
Hinweis: Dieses Feature befindet sich im Beta-Stadium. Es muss mit der LoCo-Startoption
--enable-unstable-features new_job_view beim Start aktiviert werden.

Hinweis: Das Job-Status-Reiter kann unter View > Window > Jobs aktiviert werden.
Die Vorteile des Prozess-Feedbacks sind:

• Alle zu einem Job gehörenden Kind-Jobs werden als Unterknoten des Jobs angezeigt.
• Sowohl der Hauptjob als auch die Kind-Jobs werden mit eigenen Fortschritssbalken und kur-zen Nachrichten dargestellt.
• Sowohl der Hauptjob als auch die Kind-Jobs werden mit kleinen Icons dargestellt, die denJob-Status (läuft/Error/Warning/Normal) anzeigen

Zum Beispiel kann ein RemoteSubmit-Job in drei Kind-Jobs eingeteilt werden:
• Vorbereitung (Preparation)
• FEM-Rechnung (Solving)
• Postprozessing

In diesem Fall werden die drei Kind-Jobs als untergeordnete Knoten des Hauptjobs angezeigt:
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Jeder Knoten besitzt also seinen eigenen Fortschrittsbalken, Nachricht- und Status- bzw. Erfolg-Icon.

Der Fortschrittsbalken des Hauptjobs ist abhängig vom Fortschritt der Kind-Jobs. Welchen Anteil amFortschritt jeder Kindjob am Hauptjob hat, ist in den Skripten definierbar.
Hinweis: Für RemoteSubmit-Jobs benötigt LoCo diverse Informationen (Gewichtung, Fortschritt, ...), umdie Knotenstruktur usw. eines Kind-Jobs anzuzeigen. Die Skripte/Clusterskripte müssen diese Informa-tion in einer bestimmten Datei in einem bestimmten Format ablegen. Für weitere Informationen stehtder LoCo-Support zur Verfügung.

1.3 Staged Tree

Das Staged Tree Feature bietet ein alternatives Bedienkonzept für LoCo an. In Zukunft wird dieses Be-dienkonzept die aktuelle Navigation über PoolTree und RunStudyTree ersetzen. Ziel ist es, eine intuiti-vere und schnellere Navigation zu ermöglichen. Dazu wird die Navigation auf mehrere Ebenen (Stages)aufgeteilt. Der Anwender kann in jeder Ebene Selektionen vornehmen, welche, soweit dies möglich ist,auch dann erhalten bleiben, wenn er in anderen Ebenen etwas anderes selektiert. So bleibt beispielswei-se die Selektion auf des Runs erhalten, wenn der Anwender die PoolVersion wechselt, vorausgesetzt, inder neu gewählten PoolVersion existiert der gleiche Run (bzw. eine passende RunConfig). Auf diese Wei-se kann der Anwender wesentlich schneller zwischen unterschiedlichen PoolVersionen wechseln, ohneden Fokus auf die aktuell relevanten Runs zu verlieren.
Hinweis: Dieses Feature befindet sich noch im Beta-Stadium. Es muss mit der Kommandozeilenoption
--tree-browser-type=staged aktiviert werden.
Nach Aktivierung werden im “Browser” View nicht mehr die zwei Reiter Pool und Runs angezeit. Stattdes-sen werden im Stage Tree dem Anweder von oben nach unten folgende Selektionen angeboten:

• Pool und Baum/Tree
• Pool Version
• Pool Gruppe/Komponenten
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• Run/RunConfig(s)

Auf der Pool versions Ebene sind aktuell bereits folgende Filter verfügbar:
• Pool Version
• Pool Version tag value
• Pool Version owner
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Die Filter werden bei aktivierter “Staged Tree” Navigation für die Bereiche Pool Versions und Runs jeweilsseperat eingestellt. Die Filter welche im Pool Versions eingetstellt werden können, beziehen sich nur aufdie PoolVersionen. Die bisherigen Filter werden auf der Runs Ebene weiter verwendet und beziehen sichimmer nur auf die Runs, welche zur aktuell gewählten PoolVersion gehören.
Im Runs werden ab sofort, die aufgebauten RunConfigs (Runs) als untergeordnete Knoten der RunCon-figs angezeigt. Da ein aufgebauter Run immer zu einer bestimmten RunConfig gehört, wird somit sicher-gestellt, dass dem Anwender dieser Zusammenhang bewusst wird.

1.4 Kontext Filter

Über die Kontext Filterung kann die Konfiguration des LoCo-Servers so eingerichtet werden, dass bei-spielsweise Attribute, KomponentenTypen, Namensschemas, usw. nur dann sichtbar werden, wenn sie
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für den Kontext, in dem der Anwender sich bewegt, auch relevant sind. So kann z.B. ein Attribut so defi-niert werden, dass es nur für bestimte Disziplinen sichtbar wird. Oder ein Pool kann für einen bestimm-ten OEM vorgesehen werden und es wird verhindert, dass Attribute und KomponentenTypen sichtbarwerden, die ausschließlich von anderen OEMs verwendet werden.
Auf diese Weise soll sichergestellt werden, dass der Anwender in Zukunft nich mehr mit so vielen At-tributen und KomponentenTypen konfrontiert wird. Stattdessen sollen nach möglichkeit nur noch dieElemente sichtbar sein, welche für den jeweiligen Anwender auch relevant sind. Dies soll die Komplexi-tät für den einzelnen Anwender reduzieren.
Ab der LoCo Version 1.67.11 werden die Kontext Filter per default aktiviert.
Hinweis: Dieses Feature hängt in hohem Maße davon ab, wie gut es durch die KeyUser konfiguriertworden ist. Sollten Sie Attribute, KomponentenTypen, Namensschemas oder ähnliches vermissen, somelden Sie dies bitte ihrem Ansprechpartner. Im Zweifelsfall können sie das Feature beim Start über die
--disable-context-filtering deaktivieren.
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KAPITEL 2

Verbesserungen

• [#4811] - Erhöhung der SQLite page_size zur Performancesteigerung
Die verwendete Datenbank-Software SQLite ermöglicht die Einstellbarkeit der sog. page_size. Bei SCALEwurden Tests für eine optimale Größe der page_size durchgeführt. Der ermittelte Wert wird nun beimerstmaligen Start dieser LoCo-Version verwendet. Diese tiefgreifende Änderung in der Datenbank kannin Abhängigkeit von der Datenbank-Größe einige Zeit in Anspruch nehmen. Die Änderung der page_sizesollte eine Performance-Verbesserung bei größeren Pools bewirken.

• [#4737] - Prozess-Feedback: Status der Kinder-Knoten an übergeordnete Knoten propagieren
Das Prozess-Feedback zeigt nun das schlechteste Ergebnis der Unterknoten im übergeordneten Knotenan. Damit wird sichtbar, ob es Probleme in einem Unterprozess gegeben hat.

• [#4818] - Prüfen der Betriebssystem-Version beim Starten von LoCo
Die LoCo Executable prüft nun, ob die Betriebssystem-Version mit der Version übereinstimmt, für dieLoCo gebaut wurde. Diese ist insb. für Minor-Releases bei den Linux-Distributionen relevant.

• [#4804] - Abrufen der BugReports durch ServiceADMs wieder ermöglichen
• [#4686] - Compare&Merge für mehr als zwei PoolVersionen ermöglichen
• [#4552] - Datenbank-Backup als .tar-Datei anlegen

Die neuen LoCo-Versionen werden bei den Datenbank Upgrades, Datenbank Backups als .tar-Dateienerstellen, sofern dies vom User nicht explizit abgelehnt wird. In der .tar-Datei wird LoCo nicht nur diealte Datenbank, sondern auch andere notwendige Dateien wie z.B. deafult.ldb.key.gpg bei ei-ner verschlüsselten Datenbank miteinpacken. Die ergzeugte .tar-Backup-Datei hat ein Namenformat
default_backup_DATUM_ZEIT.ldb.tar. Wenn es nötig wird, eine Backup-Datei in LoCo zu öffnen-etwa wenn das Upgrade fehlgeschlagen ist -, kann es über File > Open > Database und dem Open adatabase-Dialog geöffnet werden:

In dem Dialog unten rechts kann ein Dateienformat selektiert werden:
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Wenn das Format LoCo2 database backups selektiert wird, und zum Ordner, in dem das Backuperstellt wurde, navigiert wird, wird der User die Backup-.tar-Datei direkt in LoCo öffnen können. Es istnicht notwendig, die .tar-Datei selbst zu entpacken und in LoCo nur die defaul.ldb einzulesen, oderdie Backup-Dateien umzubenennen.
• [#4538] - Verbesserung der Lesbarkeit von Schrift für Menschen mit Rot-Grün-Schwäche
• [#4504] - Aktivierung der fortgeschrittenen Kompression im Vault für alle Brandings
• [#4437] - Entferung der Warnung, das die Zeilenlänge bei Parameterersetzung länger als 80 Zei-chen wird
• [#4408] - Bereitstellung des Filters für die PoolVersionen um die letzen [n] PoolVersionen vor currentanzuzeigen
• [#4375] - Verfügbarmachung der in einer PoolVersion vorhandenen Dependencies wie provides,requires und run_after per Dropdown
• [#4348] - Berücksichtigung der Zeilen-Sortierung beim Exportieren von Parametertabellen als .csv-Datei
• [#4104] - Aufruf der guilabel:News für den Anwender besser auffindbar machen

Die News sind jetzt unter guilabel:Extra > News aufrufbar.
• [#4621] - Automatischer Import von Bildern nach Schließen eines Editors

Werden beim Bearbeiten einer Komponente Bilder im Arbeitsverzeichnis abgelegt, so liest LoCo die-se nach dem Schließen des Editors ein und speichert sie an der Komponente. Die Bilder sind sichtbar,wenn die Komponente angewählt wird und unter Properties der Reiter Images ausgewählt wird. Die-ses Feature muss beim Start von LoCo über die Kommandozeile aktiviert werden: –enable-feature im-port_images_after_edit
• [#4983] - Warnung anzeigen, wenn es keine aktiven Runs für den Assembly-Dialog gibt

Wenn alle Runs in einer Gruppe deaktiviert sind, bekommt der Anwender ein Warnungsfenster beimAufruf des Assembly-Dialogs.
• [#4807] - ANSA Start abändern

Bereitgestellte Buttons der ANSA_TRANSL werden auch in ANSA geladen.
• [#3377] - Nachricht “evaluation of parameter x did not yield any result” nicht mehr loggen
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KAPITEL 3

Bugfixes

• [#5034] - Editieren einer Komponente führt zur Aktualisierung derselben, obwohl der Blob nichtverändert wurde
• [#5027] - Bearbeiten einer public Komponente im HG funktioniert nach dem use as current nicht
• [#5004] - LoCo Masterkey nur sicher neu schreiben
• [#4978] - Assembled Runs unter MultiRunConfigs nicht mehr aufgelistet
• [#4888] - Abfrage zur Erstellung von neuen Poolversionen erscheint doppelt
• [#4886] - BLOBNotObtainedError bei Diff aus HistoryGraph/C&M
• [#4848] - DeriveNew auf eingehängtem Pool wirft TB Can’t observe pool version until all modificationson pool version are finished
• [#4843] - LoCo friert beim Import von mehr als 10 Komponenten ein
• [#4827] - Parametertabelle bei Leerzeichen im Parameternamen nicht mehr benutzbar
• [#4809] - LoCo kann abstürzen, wennmehr als ein LoCo-Prozess in die selbe Log-Datei geschriebenwird
• [#4785] - LoCo friert, beim Versuch eine getoggelte Parameterliste anzuzeigen, unter Windwos ein
• [#4777] - RunStudyTree ist nach Ableiten einer neuen PoolVersion leer, wenn before current-Filtergesetzt ist
• [#4722] - Grid beim Setzen von Attributen extrem langsam -> bis zum Fehler recursion depth
• [#4685] - Deaktivierte RunConfigs werden nach Bearbeitung der Mutter-MultiRunConfig aktiviert
• [#4662] - LoCo submitted nicht die selektierten Runs, sondern nur den Run, der sich beim Auslösendes Submits unter der Maus befindet
• [#4651] - Unwirksamen Run Filter Description im RunStudyTree entfernen
• [#4641] - Änderungskommentarabfrage verhindert Löschen mehrerer Zeilen in Parametertabelle
• [#4578] - Einfügen einer ShortDescription per Copy&Paste in Komponenten mit mehreren Asso-ziationen führt zu Änderungen an mehreren weiteren Komponenten
• [#4577] - Refresh-Problem in neuer JobView bei Änderung der Größe
• [#4570] - Zeitintervall für unattended cleanups im Storage Janitor wird falsch gespeichert
• [#4566] - Falsches Encoding im Submitskript führt zu Abbruch beim SOAP RemoteSubmit
• [#4483] - Replace von private Komponente in HG schlägt fehl
• [#4284] - HistoryComment wird nicht abgefragt
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• [#4239] - Kopieren von Parameterzeilen funktioniert nicht
• [#4164] - Account Manager: Filter nach User funktioniert nicht bei automated requests
• [#4110] - Beim Ändern einer Parametertabelle erscheint keine Aufforderung zur Eingabe eines His-tory Kommentars
• [#4081] - Replace with preprocessor component: LoCo fragt zweimal nach History-Kommentar
• [#3800] - Copy&Paste von Snippets möglich, die einem Komponenten-Typ nicht zugewiesen wur-den
• [#3057] - Bei der Verwendung von Pfeiltasten für die Navigation im Grid werden Properties nichtaktualisiert
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